Flight Deck Interval Management Display
Elements, Information and Annunciations Database
User Guide

Jeff Lancaster, Michael Dillard, Erin Alves, and Olu Olofinboba
Honeywell International Inc., Golden Valley, Minnesota

December 2014
Since its founding, NASA has been dedicated to the advancement of aeronautics and space science. The NASA scientific and technical information (STI) program plays a key part in helping NASA maintain this important role.

The NASA STI program operates under the auspices of the Agency Chief Information Officer. It collects, organizes, provides for archiving, and disseminates NASA’s STI. The NASA STI program provides access to the NTRS Registered and its public interface, the NASA Technical Reports Server, thus providing one of the largest collections of aeronautical and space science STI in the world. Results are published in both non-NASA channels and by NASA in the NASA STI Report Series, which includes the following report types:

- **TECHNICAL PUBLICATION.** Reports of completed research or a major significant phase of research that present the results of NASA Programs and include extensive data or theoretical analysis. Includes compilations of significant scientific and technical data and information deemed to be of continuing reference value. NASA counter-part of peer-reviewed formal professional papers but has less stringent limitations on manuscript length and extent of graphic presentations.

- **TECHNICAL MEMORANDUM.** Scientific and technical findings that are preliminary or of specialized interest, e.g., quick release reports, working papers, and bibliographies that contain minimal annotation. Does not contain extensive analysis.

- **CONTRACTOR REPORT.** Scientific and technical findings by NASA-sponsored contractors and grantees.

- **CONFERENCE PUBLICATION.** Collected papers from scientific and technical conferences, symposia, seminars, or other meetings sponsored or co-sponsored by NASA.

- **SPECIAL PUBLICATION.** Scientific, technical, or historical information from NASA programs, projects, and missions, often concerned with subjects having substantial public interest.

- **TECHNICAL TRANSLATION.** English-language translations of foreign scientific and technical material pertinent to NASA’s mission.

Specialized services also include organizing and publishing research results, distributing specialized research announcements and feeds, providing information desk and personal search support, and enabling data exchange services.

For more information about the NASA STI program, see the following:

- Access the NASA STI program home page at [http://www.sti.nasa.gov](http://www.sti.nasa.gov)
- E-mail your question to help@sti.nasa.gov
- Phone the NASA STI Information Desk at 757-864-9658
- Write to: NASA STI Information Desk Mail Stop 148 NASA Langley Research Center Hampton, VA 23681-2199
Flight Deck Interval Management Display
Elements, Information and Annunciations Database
User Guide

Jeff Lancaster, Michael Dillard, Erin Alves, and Olu Olofinboba
Honeywell International Inc., Golden Valley, Minnesota
Index

• About the User Guide
• Getting Started
• FIM Literature Database
• Using the Database
  I. Describing Concepts
  II. Conceptual Frameworks
  III. Queries
• Entering New Concepts in the Database
• Troubleshooting & Maintenance
About the User Guide
About the User Guide

• The User Guide details the Access Database provided with the Flight Deck Interval Management (FIM) Display Elements, Information, & Annunciations program
  – The goal of this User Guide is to support ease of use and the ability to quickly retrieve and select items of interest from the Database

• Content
  – The Database includes FIM Concepts identified in a literature review preceding the publication of this document
  – Only items that are directly related to FIM (e.g., spacing indicators), which change or enable FIM (e.g., menu with control buttons), or which are affected by FIM (e.g., altitude reading) are included in the database

• The guide has been expanded from previous versions to cover database structure, content, and search features with voiced explanations

• Last edited: June 17, 2014
Contact Information

- **Honeywell International Inc.**
  - Aerospace Advanced Technology
  - 1985 Douglas Drive N.
  - Golden Valley, MN 55422

- **NASA Task Monitor:**
  - Kara Latorella, Ph.D.
  - Mail Stop (MS) 152
  - NASA Langley Research Center
  - Hampton, VA 23681-2199
  - Email: k.a.latorella@nasa.gov

- This user guide and the accompanying database were developed by Honeywell International Inc. and NASA Langley (Airspace System Program):
  - With sponsorship from the FAA Human Factors Division (ANG-C1) and
  - With support from a reimbursable agreement (Technical Direction 14) from the FAA’s Human Factors Division to NASA Langley
How to use the User Guide
How to use the User Guide

• This Powerpoint slideshow is intended to help users understand the organization of information within the FIM Database and how to view and edit this information.

• Users can benefit from having the FIM Access database open while progressing through the guide.

• The speaker icon indicates that there is an audio file associated with the content of the slide.
  – Double click the speaker icon to listen.
  ◆ Example audio file at the top of the slide.
Getting Started
Getting Started

• Architecture
  – The FIM database was built and tested on Microsoft Access 2007 (32-bit) with Service Pack 3 installed on Windows 7
  – Although Access 2007 is a 32-bit application, it can run and has been tested on both 32-bit and 64-bit versions of Windows 7

• It is not known whether the database can be developed or viewed on earlier or later versions of Microsoft Access
  – Using the database with earlier or later versions could corrupt the database and prevent it from working on Access 2007
  – Users should preserve an original, unedited, unopened copy of the Database from the source in .zip format
Getting Started

• Running the Database
  – The database is provided in a .zip package file
  – To run it, users should
    ◦ Download the .zip file
    ◦ Open it with archiving software (e.g., WinRAR, WinZip, 7-Zip)
    ◦ Extract the archive to a chosen file location
  – Next, the user should navigate to the chosen file location, open the database directory, and open the .mdb file

• The Database file is called:
  – Database.mdb

• Opening this file will open the Database; however, one more critical setup step must be taken to allow the user to freely view and edit the database
Macros

• Users **MUST** enable macros in order to use the Database. This operation only has to be performed once during the initial setup.

• Users can disable macros from executing at a later time if desired. In other words, this action can be undone.

• The following steps must be taken to enable macros:

<table>
<thead>
<tr>
<th>Steps Required to Enable Macros</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open the Database</td>
</tr>
<tr>
<td>2. Click the Office Button in the top left corner</td>
</tr>
<tr>
<td>3. Click <strong>Access Options</strong></td>
</tr>
<tr>
<td>4. Go to <strong>Trust Center</strong> in the left panel</td>
</tr>
<tr>
<td>5. Click on <strong>Trust Center Settings</strong>...</td>
</tr>
<tr>
<td>6. Go to <strong>Macro Settings</strong> in the left panel</td>
</tr>
<tr>
<td>7. Select the radio button: <strong>Enable all macros</strong></td>
</tr>
<tr>
<td>8. Click OK</td>
</tr>
<tr>
<td>9. Click OK</td>
</tr>
<tr>
<td>10. Close the database</td>
</tr>
<tr>
<td>11. Re-Open the database</td>
</tr>
</tbody>
</table>
Overview of Database Content

- **Viewing Concepts** – users can browse the contents of the FIM Concepts
- **Querying Concepts** – users can view a subset of information
- **Concepts** – summary of FIM concept at a global level
- **Displays** – details display locations included in a concept
- **Elements** – combination of features
  - E.g., PDA spacing box with ownship, target ship, & spacing boxes
- **Features** – individual components (e.g., ownship icon)
Overview of Database Content

The database also characterizes sources of FIM information with **Conceptual Frameworks**. These include:

- **Behavioral Frameworks** - characterization of FIM concept behavior
  - E.g., Algorithm used in a studying using a FIM concept
- **Evaluation Frameworks** - characterization of the scenarios used for FIM concept evaluations
  - E.g., Evaluation platform and apparatus used
- **Results Frameworks** - characterization of FIM concept results
  - E.g., Performance measures and outcomes
## Acronyms

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ATP</td>
<td>Airline Transport Pilot</td>
</tr>
<tr>
<td>CDTI</td>
<td>Cockpit Display of Traffic Information</td>
</tr>
<tr>
<td>E-SVS</td>
<td>Enhanced-Synthetic Vision System</td>
</tr>
<tr>
<td>EFB</td>
<td>Electronic Flight Bag</td>
</tr>
<tr>
<td>EICAS</td>
<td>Engine Indication and Crew Advisory System</td>
</tr>
<tr>
<td>FAA</td>
<td>Federal Aviation Administration</td>
</tr>
<tr>
<td>FIM</td>
<td>Flight Deck Interval Management</td>
</tr>
<tr>
<td>I-SIM</td>
<td>Interface Study for Interval Management</td>
</tr>
<tr>
<td>IMSPiDR</td>
<td>Interval Management with Spacing to Parallel Dependent Runways</td>
</tr>
<tr>
<td>NASA LaRC</td>
<td>NASA Langley Research Center</td>
</tr>
<tr>
<td>NASA ARC</td>
<td>NASA Ames Research Center</td>
</tr>
<tr>
<td>VNAV</td>
<td>Vertical Navigation</td>
</tr>
</tbody>
</table>
Support Functions

• Several support-related functions are provided
  – Acronym List
  – Visual Aids
    ❖ Each Concept contains a detailed Visual Aid as an organizational aid
    ❖ To open, click the **Visual Aid** button when viewing a Concept
      • Visual Aids are dynamic Microsoft Word documents (.docx)
      • Users can expand and collapse chosen levels of the hierarchy
• Printing
  – All aspects of the FIM database can be printed, but Concept details have specifically been formatted for printing
    - These forms have a width of 8” and span multiple pages vertically
    - Page 2 is reserved for tables that documents Contextual Conditions & Frameworks
  – To Print Concept details, simply click the Print button
    - If all records at the current Hierarchy level are desired, set the Print Range to “All”
    - If only the Current record is desired, set Print Range to “Selected Record(s)”
• Source Articles
  – Each Form contains a link to all source materials (ranging between 1 and 3 sources) associated with the currently selected Concept
  – These source materials exist in various file formats (.pdf, .docx, .pptx, hyperlink to url)
  – If the source materials are freely available, the link will directly open the files
    ◆ Users may be prompted with a warning about opening links from unknown source. Click OK if this occurs
  – If the source materials are not freely available, clicking the link will direct the user to a website containing the abstract, full citation, and information on how to purchase the source materials
    ◆ Articles that are not freely available are denoted by a dollar sign ($) next to the link
Support Functions

• Version Control
  – Any time a modification is made to a Form and saved, user information is stored in the database
  – The following fields are logged:
    ✦ Last Updated - date and time that the change was made
      • Rather than keep a record of changes, this entry only reflects the most recent change made to the specific Form
      • This box will not reflect the date and time of changes made using the Tables. Changes must be made within the Forms for the box to reflect the date and time of the modification
    ✦ User – User name defined within Windows
    ✦ Computer – Name of computer defined within Windows
    ✦ Domain – internet domain that the user is connected to
Images

• Images are used throughout the database
• Any time an image appears too small
  – Double-click the image
  – Click Open to view the full-size image
FIM Literature Database
FIM Literature Database (EndNote)

- **List of articles** from domestic and international sources that have designed and/or developed FIM displays:
  - Sources include FIM pilot interface features, information elements, and annunciations designed to support FIM operations
  - 43 articles comprise the EndNote database

- **EndNote** has been used to catalog FIM concept literature, and supports database users in many ways:
  - Arrange the order of research titles, authors, & publication dates
  - Change Layout options to match your monitor and preferences, such as showing the Preview, Reference, and PDF Viewer panels on the right side of the screen to fit widescreen monitors
  - Open PDFs in a separate PDF window for viewing references
To use the literature database, you must have the EndNote program

Download a 30-day trial version of EndNote below:

http://endnote.com/downloads/30-day-trial

Note that most of the articles are also available via the FIM Concept database, as FIM Concepts are tied to the articles discussing them.
• The EndNote program window & associated fields

Click here to enlarge the article

Article Window – read each article here – click & drag left edge to enlarge the viewable area

Publication Year column – click @ top to sort ascending or descending

Authors column – click @ top to reorder the list alphabetically (A-Z ; Z-A)

Article Title column – click @ top to reorder the list alphabetically (A-Z ; Z-A)
Using the Database
File Structure

• All database files are contained within a series of directories that are created after decompressing the .zip package file

• After unzipping this file, a parent directory will be created (\Access Database\) that contains several subdirectories and files within it
  – These subordinate directories contain images and source materials for each of the Concepts

• This is the location where users can modify existing files or add new directories for new Concepts
  – The main database file (Database.mdb) also resides in this directory
File Structure

• The .mdb file **must** be left in its original location (\Access Database\Database.mdb) in order for hyperlinks to function

• If users want to open the database from another location without having to open the directory containing the .mdb file, a shortcut should be created by
  – Right-clicking the .mdb file, selecting Send to, then selecting Desktop (create shortcut)
Taxonomy & Nomenclature

• FIM Concepts adhere to differing principles. Therefore, a common hierarchy and classification scheme was derived for categorization, leading to a tripartite classification such that the following is included for each Concept:

1. **Information Classification** – how information is used, location
2. **Phenomenological Classification** – what information looks like, level of hierarchy
3. **Citation Classification** – references a Concept is used in
I. Describing Concepts
Describing Concepts

• Part of this classification effort included designating specific labels for the different “levels” of the Hierarchy

• Each label and the corresponding level of the Hierarchy are detailed on the following slide within the context of the Interface Study for Interval Management (I-SIM) Concept from NASA Langley Research Center (NASA LaRC):
# Describing Concepts

<table>
<thead>
<tr>
<th>Level of Hierarchy</th>
<th>Item Name</th>
<th>Description</th>
<th>Superordinate Level (“Parent”)</th>
<th>Subordinate Level (“Child”)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concept</td>
<td>I-SIM</td>
<td>Highest level of hierarchy; provides overview of all Displays contained within chosen Concept</td>
<td>N/A</td>
<td>Display</td>
</tr>
<tr>
<td>Display</td>
<td>Configurable Glass Display</td>
<td>Details all Displays used within chosen Concept</td>
<td>Concept</td>
<td>Element</td>
</tr>
<tr>
<td>Element</td>
<td>FIM Progress Indicator</td>
<td>Details all Elements used within a specific Display</td>
<td>Display</td>
<td>Feature</td>
</tr>
<tr>
<td>Feature</td>
<td>Progress Indicator Bug</td>
<td>Lowest level of hierarchy; identifies components that make up an Element</td>
<td>Element</td>
<td>N/A</td>
</tr>
</tbody>
</table>

![Partial decomposition of I-SIM Concept](image-url)
Describing Concepts

To view a Concept, select View Concepts from the Main Menu
- Then select Concept Overview followed by the desired Concept
- Hovering over a button provides the full Concept name and source materials
- Each tab in the Concept Index contains all of the Concepts associated with the Institution identified on the Tab
  - For example, NASA LaRC
Top level of a Concept

- Upon making a selection, the chosen Concept will open
  - This is the “highest” level and it provides an overview of the overall Concept with links to all subordinate Displays used within this specific Concept
- Users will find information that describes the Concept, Display, Element, or Feature, such as links to source materials
Navigating Concepts

• Navigating Concepts is accomplished by
  – Travelling to subordinate levels of the Hierarchy
  – Travelling to superordinate levels of the Hierarchy
  – Staying at the current level and moving to the next or previous Entry

• Each of these maneuvers can be associated with a relative direction
  – Up, Down, Left, Right

<table>
<thead>
<tr>
<th>Relative Direction</th>
<th>Navigates To</th>
<th>Form Button</th>
<th>Example from Fig. 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up</td>
<td>Superordinate Item (“Parent”)</td>
<td>Any button above Red box in Return to: Menu</td>
<td>[Concept Index]</td>
</tr>
<tr>
<td>Down</td>
<td>Subordinate Item (“Child”)</td>
<td>Any Item listed in Subordinate [Items]</td>
<td>(2) E-SVS [View Display]</td>
</tr>
<tr>
<td>Left</td>
<td>Previous Item at same level of Hierarchy</td>
<td>Prev [Item]</td>
<td>[Prev Concept]</td>
</tr>
<tr>
<td>Right</td>
<td>Next Item at same level of Hierarchy</td>
<td>Next [Item]</td>
<td>[Next Concept]</td>
</tr>
</tbody>
</table>
Navigating Concepts

• Navigating to the previous and following entries at one level of the Hierarchy can be thought of as “horizontal”, or “left” and “right” moves, respectively.

• While navigating to superordinate and subordinate levels can be thought of as “vertical”, or “up” and “down” moves, respectively.

• Users are encouraged to experiment with the navigation-related tools to gain a better understanding of the connections between the levels of the Hierarchy.
Horizontal Navigation – Left and Right

- To view other entries at the same level of the Hierarchy, the Next [Entry] and Prev [Entry] buttons should be used.

- Given the number of FIM concepts, certain entries are used in multiple Concepts.

- Whenever an entry is presented multiple times, all duplications of the entry beyond the first are marked as Duplicates in the Database.
Horizontal Navigation – Left and Right

- When horizontally browsing entries on the same level of the Hierarchy (left and right), duplicate entries will be skipped over
  - This is designed to speed up browsing and prevent clutter
  - Duplicate entries still exist in the Database and show up in queries, but they do not show up when browsing left and right
  - Duplicate entries can be navigated to by vertically travelling up or down from a subordinate or superordinate entries
Entries are only marked as duplicates if they are exactly the same as another entry

- E.g., ownships used in IMSPiDR (Shay et al., 2012) and NASA LaRC Airborne Precision Spacing for Dependent Parallel Approaches - EFB Version (Volk et al., 2012)

- However, not the ownship used in the 3D-CDTI Concept (NASA, 2004)
Navigating Upward

- Returning to Superordinate Levels
  - The red box on the right side of the Form functions as an anchor that indicates the current level of the Hierarchy that is being viewed
    - In addition to this anchor, the header at the top of the page identifies the current level via text
  - Buttons below the red box are “grayed out” and cannot be clicked because the navigation buttons on the right side of the Form are designed to return to higher levels
  - Buttons above the red box will appear black and can be clicked because they are superordinate
Navigating Upward

- When navigating upwards to superordinate levels, the user can choose which level to return to
- There is no requirement to travel upwards one level at a time
  - When viewing a Feature (the lowest level of the Hierarchy), users can skip directly up to the superordinate Concept, thereby skipping over Elements and Displays
Navigating Downward

• All of the subordinate entries associated with the entry currently being viewed are presented in the center below the image.

• These subordinate entries are specifically associated with the entry being viewed and do not appear for any other entry.

• The figure associated with the current entry will contain notation that corresponds with the entries listed in the Subordinate [entry] list. This notation may appear in two formats:
  – A simple numerical notation, or
  – Two hyphenated numbers.
Navigating Downward

- Hyphenated notation is used to denote that subordinate entries are tied together (e.g., different pages of the same Display) or are variations of the same entry (e.g., 2D view and 3D view of the same Display).
- Any time hyphenated notation is used, the images for the subordinate entry will be “cascaded” to indicate that they are grouped together.
- If the image appears too small, the user can double-click the image, and click Open to view the full-size image.
Navigating Concepts

- When the user navigates to a subordinate entry (navigates “downward”), a new Form is opened
- Users may develop a better understanding by leaving all superordinate Forms open while navigating down the Hierarchy
- After navigating to the Feature level, four Forms will be open
Given the diversity of the approaches to FIM, there are Concepts that do not utilize all 4 levels of the Hierarchy, as the Hierarchy was devised to be overlaid across all FIM Concepts.

Generally, this occurs at the Element level when a subordinate entry used within a Display is neither clustered along with other entries nor can it be broken down further.

- This creates a situation where the subordinate Entry does not constitute an Element by itself; rather, it is an isolated Feature present within the Display.
Jumping

• Any time an isolated Feature is present within a Display, the text *Jump* is presented next to the Feature under **Subordinate Elements**
  - The word “*Jump*” is used because when one of these Features is selected, the database will automatically jump from the Display level to the Feature level, thereby **jumping over** the Element
Jumping

• When this occurs, a pop-up message indicates that a jump to a lower/higher level is occurring
  – The user must acknowledge this message to proceed

• The same operation is executed when a user travels back up the Hierarchy
  – E.g., when viewing a Feature, if a user tries to return to the parent Element, then it will be jumped and a notification will be presented before navigating up to the superordinate Display

• Examples are provided on the next slide
Jumping

• Ex. 1: Jump required  (Concept: APS for DPA - Glass Cockpit Version, Volk et al., 2012)
  – Selected Coupled Aircraft is an isolated Feature within the Navigation Display (ND2)
  – There is no element, so the database jumps over the Element level
  – Concept → Display → Element → Feature
    (APS for DPA) (ND2) (Selected Coupled Aircraft)

• Ex 2: No jump required  (Concept: APS for DPA - Glass Cockpit Version, Volk et al., 2012)
  – Navigating down to Ownship
  – Concept → Display → Element → Feature
    (APS for DPA) (ND2) (Conformance Box) (Ownship)
Contextual Conditions

• The database includes documentation of Entries that may only appear conditionally by identifying the contextual conditions under which FIM Displays, Elements, and Features appear
  – This includes documentation of
    ◆ Display surface on which the Entry is presented
    ◆ Conditions under which Entries appears/disappears
    ◆ Information that the Entry conveys
    ◆ Action or decision the information supports
Contextual Conditions

• Documentation of contextual conditions is provided for each Display, unless the Display only contains one Element
  – The same principle applies to Elements – no contextual conditions are provided if the Element contains only one Feature
  – Additionally, no documentation is provided for Elements being jumped
  – Documentation of contextual conditions is rarely required for Features due to the fact that Features are classified at the most basic level

• Documentation for some Displays and Elements is quite extensive, making the table lengthy
  – In the event that figures are not easily viewable, a user can double-click the contextual table to fully expand it
II. Conceptual Frameworks
Conceptual Frameworks

• Additional functionality has been added to the FIM Database to characterize sources of FIM information that FIM Concepts are drawn from

• These include:
  – **Behavioral Frameworks** – characterization of FIM Concept behavior
  – **Evaluation Frameworks** – characterization of the scenarios used for FIM Concept evaluations
  – **Results Frameworks** – characterization of FIM Concept results
Behavioral Framework

- Characterization of FIM concept behavior, such as:
  - Algorithmic approaches
    - E.g., EUROCONTROL CoSpace
  - Alert thresholds
    - E.g., spacing below tolerance
  - Display/coding change behaviors
    - E.g., traffic becomes the target aircraft
  - Related operational constraints & assumptions
Evaluation Framework

• Characterization of the scenarios used for FIM concept evaluations:
  • Dependent constructs/measures
  • Characteristics of research participants
    • E.g., pilot experience w/FIM; ATP-rated
  • Evaluation platform/apparatus
    • E.g., motion simulator; flight test
Results Framework

• Characterization of FIM concept results:
  • Efficacy of design features
  • Performance measures
  • Other relevant/salient results
Viewing Conceptual Frameworks

• The Frameworks can be viewed in the following locations:
  – Behavioral Framework – Concepts Form
  – Evaluation Framework – Evaluation Form
  – Results Frameworks – Results Form

• The 3 Frameworks are linked to one another and to the original Hierarchy with buttons
III. Queries
Queries

• The Database supports a wide selection of Queries
• Queries are separated into two major categories:
  – Concept Queries
    • Item Queries – returns which Concepts use a specific entry or type of formatting
    • Location Queries – returns all selected Display surfaces
    • Bibliography Queries – returns all Concepts associated with a specific Author, Affiliation, or year of publication
    • Control Queries – returns Elements & Features that do/do not control FIM systems
  – Conceptual Framework Queries
    • (Detailed later)

• Given the diversity of the information contained within the various Concepts, the queries function as “OR” queries that deliver a “superset” of all queried entries
Queries

- Users can click the **Reset** button to uncheck and clear all fields.
- After performing a Query, users can save the Query output as a .pdf file by clicking the **Save Query** button.
  - This allows users to share the results of a specific query with others that may not have the database.
- Users can also open the any relevant Concepts directly from the Query output.
- If no results are returned from a Query, user will see a pop-up message.
- Once users have finished examining the output from a specific query, they can navigate back to either the Query Index or the Main Menu.
Item Queries

- To run an Item Query, users should select the Item Tab within Queries. Item Queries require the user to specify three pieces of information:

<table>
<thead>
<tr>
<th>Query Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Items</td>
<td>Items/Formatting the user wishes to find</td>
</tr>
<tr>
<td>2. Colors</td>
<td>Desired colors of the selected Items in Step 1</td>
</tr>
<tr>
<td>3. Level of Hierarchy</td>
<td>Level of the Hierarchy at which to conduct the search (Concepts, Displays, Elements, or Features)</td>
</tr>
</tbody>
</table>
Item Queries

• Users should specify search criteria by selecting the check boxes next to the desired Items and Colors before clicking the button corresponding to the level of the Hierarchy at which the user wishes to perform the search
Item Queries

• A search for multiple Items and multiple Colors will return all records matching the search criteria at the chosen level of the Hierarchy. For example, if a user searches for:

Triangles or Rectangles that are Green, Cyan, Magenta, or Yellow at the Feature level.
Item Queries

• One Feature returned in the Query Report is the Target Aircraft – VNAV Display that consists of:

| Triangle or Rectangles that is Green, Cyan, Magenta, or Yellow | As opposed to | Triangle AND Rectangle that is Green, Cyan, Magenta, AND Yellow |

• The Feature does not have to contain a Triangle AND a Rectangle, only a Triangle OR a Rectangle
  – The same for Colors - Items must be Green, Cyan, Magenta, OR Yellow - not Green, Cyan, Magenta, AND Yellow

• Note that the exact same query can be conducted for Displays that contain triangles or rectangles that are green, cyan, magenta, or yellow
Item Queries

• The FIM database fully supports user Queries at all four levels

• If the exact same Query were run at the Concept level, the output would consist of the Enhanced/Synthetic Vision Concept, among others, which contain either Triangles OR Rectangles, that are Green, Cyan, Magenta, OR Yellow
Item Queries

• In order to perform a Query looking for a specific Color, users should check the All box listed under Desired Items
  – Failure to select any Items or any Formatting will result in a message box that prompts the user to select at least one type of information for the Query

• The same logic above applies to Item-only queries with no concern for Color
  – Users should select All Colors
Location Queries

• Given that Displays are used to present information and annunciations to pilots, they are a critical component of the FIM hierarchy

• Location Queries are specific to Displays and they allow users to examine the various ways in which existing and new Displays have been used to present information during FIM operation

• To run a Location Query, users should select the Location Tab within Queries
  – Then check the boxes next to the desired Displays before clicking Search
Bibliography Queries

- Users are able to search each Concept for bibliographic information, including author last name, year of publication, or lab/institution

- Partial Queries
  - Bibliographic Queries support **partial** search terms
  - Users do not have to enter a complete search term in order to execute a query. An incomplete author last name can return results. For example:
    - Author Query for “Swie” returns all of the Concepts credited to Kurt Swieringa
    - Affiliation Query for “Ames” returns all Concepts credited to NASA Ames Research Center (NASA ARC)
      - Affiliation Query for “Lang” returns all Concepts credited to NASA Langley (NASA LaRC)
      - Affiliation Query for “NASA” returns all Concepts credited to NASA Ames or NASA Langley
    - Year Query of “20” returns all Concepts published from 2000-2999, while a query for “200” returns all Concepts published from 2000-2009
Bibliography Queries

• To run a Bibliography Query, select the Bibliography Tab within Queries and enter relevant search terms before clicking Author, Year, or Affiliation to execute the search

• While abbreviations may be used in Titles that are displayed on Forms and Menus, they are not used for Queries
  – Ensure that all Bibliography Queries use the full author or institution name (e.g., “NASA Ames” instead of “NASA ARC”)
Control Queries

• All menus, toolbars, & panels that control FIM (e.g., enable/disable, select a viewing mode within a Display) are categorized as Elements
  – Specifically, they are considered Control Elements
  – A user can specifically query the database for both Control and Non-Control Elements
  ♦ Since these entries are Elements, many of them contain subordinate Features. Therefore, users can also query the Database for Control and Non-Control Features

• Examples of Control Elements include menus with FIM information and FIM-related control options that can be manipulated

• Examples of Control Features include EFB buttons used to activate FIM procedures or a virtual keyboard used to enter text

Example of a Control Element menu containing FIM merge instructions and buttons.

Example of a Control Feature button used to activate FIM procedures on an EFB.
Control Queries

- Control Elements and Features are not formatted in terms of Items and Colors to prevent these navigation and FIM-related tools from cluttering Queries
  - Control Elements and Features are important are not central to FIM and are often embedded within menu systems commonly used for other Display functions (e.g., enabling/disabling weather)
- To run a Control Query, select the Control Tab, then click the desired button, Control Elements, Non-Control Elements, Control Features, or Non-Control Features, to execute the search
Framework Queries

- Framework Queries exist alongside Concept Queries in the Query Index. They cover:
  - Behavioral Queries – environment, operations, rules, & alerts
  - Evaluation Queries – scenario, setup, conduct, participants, & measures
  - Results Queries – efficacy, metrics, & discussion
Behavioral Queries

- The following topics are covered by Behavioral Queries:
  - **Environment** – algorithm name, GIM algorithm, wake considerations, wind data source, resolution of wind data, & other aircraft data
  - **Operations** – applicable domain, phase of flight, IM turn utilization, suspension, expected assigned spacing dimension, background possible, closely spaced runways, autoloded FMS speeds, & achieve-by point
  - **Rules** – largest and smallest speed change permitted, & STAR/SID speed constraints
  - **Alerts** – speed deviation, target aircraft issues, & speed reminder
Evaluation Queries

• The following topics are covered by Evaluation Queries:
  – **Scenario** – evaluation platform, aircraft type represented, airports used, phases of flight, duration of scenario, communication type, & intended implementation
  – **Setup** – clearance delivery, third-party flight ID voice format, & third-party flight ID CDTI format
  – **Conduct** – autothrottle use, autoflight management modes, FIM information presentation channels, typical number of speed changes, typical distance-based spacing goal, typical time-based spacing goal, & FIM events
  – **Participants** – subject experience, ratings, mean commercial flight hours, pilot teaming
  – **Measures** – performance metrics, subjective report data, observational data, & system-level measures
Results Queries

The following topics are covered by Results Queries:

- **Efficacy** – symbology, alerts, phraseology, & information presentation channels
- **Metrics** – performance metrics, subjective report data, observational data, & system-level measures
- **Discussion** – Authors positive and negative findings, suggestions for future research, & description of system-level benefits
Entering New Concepts
Database Structure

• All Database information is stored in **Tables**

• Each of the 4 levels of the hierarchy has its own table
  
  – Each **Column** within a Table represents a different **Field** (e.g., Concept Title, Authors, Image attachments), while each **Row** represents an independent entry

  – There are many types of Fields within the tables: text, image attachments, id numbers, etc

• Information for different levels of the hierarchy is entered into separate tables, but the tables are linked via ID numbers
  
  – Users should know and keep track of the ID numbers when adding new entries to the database.

• The next slide includes an example of opening Tables for Concepts, Displays, and Elements (but not Features)
Database Structure
Database Structure

- The Fields used within these Tables can be seen in the Columns, namely the ID numbers used across the Tables
  - In the Concepts Table, the first Concept (titled “3D-CDTI” from NASA Ames Research Center (ARC)) has a ConceptID of 1
  - In the Display Table, the two Displays that are part of the 3D-CDTI (2D CDTI view & 3D CDTI view) are listed on separate Rows
    - Note that they have unique DisplayIDs, since they are in fact separate Displays
    - However, they share the same ConceptID, since they are a part of the same 3D-CDTI Concept

- The same organizational hierarchy is used for Elements
  - The Element titled “(09) Ownship” has an ElementID of 9 since it is a unique Element, a DisplayID of 1, since it is associated with the 2D CDTI view, and a ConceptID of 1, since it is associated with the overall 3D-CDTI Concept from NASA ARC
Database Structure

• Take Item Queries as an example…

• Tables containing relevant information for the four levels are linked with ID numbers, so the database supports Item Queries at all levels, even if the specific information being searched exists at a different level
  – Due to the linking of Tables via ID numbers, the Query is able to return the relevant output because it can determine that a given entry, such as an Ownship (Feature), is linked to a specific Element, Display, or Concept
  – In other words, the exact same Item Query can be run at multiple levels
    ◆ Query for Elements containing an Ownship, or
    ◆ Query for Displays containing an Ownship
• When browsing Concepts, information from Tables is presented in Forms
• Forms are used for visualizing information and they are also customizable
• Forms contain numerous **Buttons** and **Text Boxes** that accept keyboard and mouse input from the user, which is required for browsing the database and initiating queries
  - Some buttons support navigation to other portions of the database, while others open external documents such as source articles. Some of the Forms contain **Tabs**
    - Whenever present, click on a desired Tab to jump to a different page within the Form
Entering New Concepts in the Database

• A user must have a clear understanding of the structure of the Database in order to enter new Concepts
• This operation ultimately requires users to open the four tables associated with the four levels of the Hierarchy (i.e., Concepts, Displays, Elements, and Features) and insert relevant information
• However, before entering information in the database, users must decompose each new Concept into its subcomponents and overlay the Hierarchy that is described above
Entering New Concepts in the Database

- Decomposing New Concepts
  - The instructions included in the tables on the following slides assume that the user has already gathered all support materials needed to enter a new Concept in the database.
  - This process can be thought of as “breaking down” a Concept.
  - Each Concept must be broken down in such a way that allows it to fit within the existing hierarchy that is implemented in the database.
  - To understand how the database is layered and how support materials are organized, users should start by examining the existing directory structure. Examples include:
    - FIM DS Using EVO Concept and its directory (\Access Database\Prinzel)  
    - Airborne Spacing CDA Concept and its directory (\Access Database\Hoffman)
Decomposing New Concepts

- Before entering a new Concept, it is recommended that a new directory be created for the new Concept.
- We have chosen to use author names for these directories, but any consistent naming convention can be used.
- The directory in our example, `\Access Database\Prinzel\`, contains the notated images, documentation of contextual conditions, source articles, and a visual aid document.
  - All of these are required to enter a new Concept into the database.
- However, any file structure can be used for images, sources, and contextual conditions.
  - For example, all supporting files for all Concepts could be placed into one large central directory, if desired.
Decomposing New Concepts

• **Visual aids and audio.wav files must** be placed in the \Access Database\LINKS\ directory

• **While hyperlinks can be created to source materials residing in any directory on a user’s computer or on the internet, these materials must remain in the initially specified directory for hyperlinks to be preserved**
  – If these source materials are moved to a different directory, the hyperlink will be broken
  – This is why a standardized procedure, where each author has a unique directory, is highly recommended
When decomposing a new Concept, the user will need four types of files:

1. Images for Concepts, Displays, Elements, and Features with notation in each image
   - .png preferred, but .jpg and .bmp can be substituted

2. Documentation of contextual conditions
   - .xlsx preferred, but .docx can be substituted

3. Source materials that the Concept is found in
   - .pdf, .docx, .ppt

4. Visual Aid
   - .docx
Decomposing Images

- After deciding what to include in a new FIM Concept, users must create images for entries at each level of the hierarchy (Concept, Displays, Elements, and Features)
  - For this example, the 3 Prinzel et al. articles all describe the same Concept
  - This Concept consists of 4 Displays, so the user should create an image for the Concept which contains these four Displays with numbers that identify each Display
    - (Access Database\Prinzel\Concept\Overall Concept.png)
  - Eventually, this will be entered into the database at the Concept level
    - When Displays are entered, they must adhere to the notation used in the Concept image
    - The first Display entered for Prinzel is the PF Left Display since it is labeled (1) in the Concept image
Decomposing Images

• The process of creating notated images when breaking down new Concepts is time-consuming but is must completed before entering into the database.

• Any image editing software can be used to create images with notations.

• For each new Concept, users should create a subdirectory for each level of the Hierarchy.
  - For the Prinzel Concept, there is a
    - Subdirectory containing the Concept image
    - Subdirectory containing all Display images and Documentation of contextual conditions
    - Subdirectory for Elements, which is empty since there are none
    - Subdirectory for all Feature images
Decomposing Images

- After decomposing the Concept level, move down to the Display level
  - Each Display is broken down in order to identify all subordinate Elements
  - Just like Concepts, an image is created for each Display with notation for each subordinate Element. Eventually, each image is entered for the relevant Displays using the notation provided
  - This process is repeated for Elements such that each Feature is identified in each notated Element image
  - Once reaching the Feature level, users cannot further break down images
  - Create an image containing each unique feature identified in the parent Element image
  - Categorize the Feature along several dimensions that can be seen in the Item Query Form or by opening the Feature Table and looking at the checkboxes
    - E.g., if a white chevron ownership Feature is being examined, note White, Chevron, and Ownership were used
Documenting Contextual Conditions

- Documentation of contextual conditions is typically accomplished with Excel spreadsheets.
- Four examples can be seen within the Prinzel subdirectory for Displays (\Access Database\Prinzel\Displays\).
- Documentation should be included for all Displays, and for Elements that contain multiple features and are therefore not being jumped over.
Source Materials

• It is recommended that all relevant source materials (.pdf, .docx, .ppt) be placed in the directory being used for the current Concept

• After hyperlinks have been created to these files, the source materials should not be moved from their original location

• If they are moved the hyperlink will not function and the file will have to be moved to its original location or a new hyperlink will have to be created that links to the new file location
Adding Audio

- Some FIM concepts employ auditory signals during FIM operation
  - If there is any mention of auditory signals within a source article, then it is indicated by a speaker icon

- If any audio file is provided by the source article, it can be included in the Database

- Clicking the Play Audio button will launch the .wav file with the user’s default audio playback software
Adding Audio

• If no auditory file is provided, whatever material that is provided in the source article (e.g., auditory signal description) is used instead
  – This is typically accomplished with an image, and can be seen in the NASA ARC Concepts (3D-CDTI and ARC Cockpit Situation Display)
Visual Aid

• Each Concept should contain a Visual Aid that helps users understand the organization of information within each Concept

• This document can be created at any point, before or after Concept entry in the database, but users may find it helpful to create this overview of the Concept before entering any information into the database

• Then based on this document, users can create all images with notation for the four levels of the Hierarchy before proceeding to database entry
• As noted above, **visual aids** and **audio .wav files** must be placed in the `\Access Database\LINKS\` directory

• Once **all** materials have been created and placed into the desired directories, users should proceed to entering this information in the database
  – This can be accomplished by using either Tables or Forms
  – This process is described in the following tables
Miscellaneous Notes

- Regarding the formatting employed in Item Queries, the “Traffic” category is distinct from “Target Ship”
  - A Target Ship is an aircraft other than Ownship that has specifically been selected for a FIM-related procedure

- The “Outline” property is used for shapes that have an outline around them, whereas “Rectangle” is used for text and stand-alone rectangular shapes

- The “Fuselage” property is used to describe shapes that resemble an airplane fuselage, as opposed to a chevron or triangle
  - Some Concepts use a fuselage icon to represent ownship, target ship, or traffic aircraft
## Step-by-Step Guide for New Entries

- **Always start at the highest level of the Hierarchy and move down while keeping track of the ID numbers at each level**
  - Concepts → Displays → Elements → Features

- **All of these steps can also be performed within the Form that is created for each new record**
  - This method of creating new entries may be preferred for users that desire a more visually-oriented graphical interface
  - Any time a change is made to a Form the record will automatically be timestamped with the current date and user information

### Field Name Instructions for Entering Concepts

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Instructions for Entering Concepts</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Concept_Title</td>
<td>Enter the Concept Title Upon doing so the ConceptID will automatically populate - Record ConceptID</td>
</tr>
<tr>
<td>2. Image (paperclip icon)</td>
<td>Double-click the cell → Add... → Navigate to and select the appropriate Concept Image</td>
</tr>
<tr>
<td>3. Source Article</td>
<td>Link to the Source Article by right-clicking on the Source Article cell → Hyperlink → Edit Hyperlink. Navigate to and select the source article. Repeat for 2nd and 3rd Source Articles.</td>
</tr>
<tr>
<td>4. Source Article Free</td>
<td>Check this box if the source materials are not free and reside behind a paywall. A dollar sign ($) will appear on the Form when this box is checked.</td>
</tr>
<tr>
<td>5. Authors</td>
<td>Enter the last names of all of the authors, separated by commas</td>
</tr>
<tr>
<td>6. Affiliation</td>
<td>Enter the affiliation of the institution associated with the Concept</td>
</tr>
<tr>
<td>7. Auditory</td>
<td>Place a check in this box if there is an auditory component within the Concept</td>
</tr>
<tr>
<td>8. WavFileName</td>
<td>Place the audio file, if any, in the \LINKS\ directory in the Database and enter the truncated filename. Remove the file extension. Ex: zbeep-1.wav would become zbeep-1</td>
</tr>
<tr>
<td>9. VisPath</td>
<td>Place the Visual Aid in the \LINKS\ directory in the Database and enter the truncated file name. Ex: v_NASA2004.docx would become v_NASA2004. Note that .docx files are required for the visual aid. Create visual aid to your liking or follow examples for other Concepts.</td>
</tr>
<tr>
<td>10. Auditory_Special</td>
<td>Place a check in this box if there is no auditory file but there is a description of an auditory component in an image.</td>
</tr>
<tr>
<td>11. Auditory_Special Image (paperclip icon)</td>
<td>Double-click the cell → Add... → Navigate to and select the appropriate image describing an auditory component</td>
</tr>
</tbody>
</table>
## Entering New Displays

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Instructions for Entering Displays</th>
</tr>
</thead>
<tbody>
<tr>
<td>ConceptID</td>
<td>Enter the ConceptID associated with the superordinate Concept Upon doing so the DisplayID will automatically populate - Record DisplayID</td>
</tr>
<tr>
<td>DisplayImage</td>
<td>Double-click the cell → Add... → Navigate to and select the appropriate Display Image</td>
</tr>
<tr>
<td>DisplayTitle</td>
<td>Enter the Display Title with appropriate notation. Ex: (2) E-SVS EICAS</td>
</tr>
<tr>
<td>DisplayTitle_</td>
<td>Enter the Display Title without notation. Ex: E-SVS EICAS</td>
</tr>
<tr>
<td>[Display Type]</td>
<td>Click the relevant checkbox corresponding to the type of Display being entered</td>
</tr>
<tr>
<td>Source Article</td>
<td>Link to the Source Article by right-clicking on the Source Article cell → Hyperlink → Edit Hyperlink. Navigate to and select the source article. Repeat for 2nd and 3rd Source Articles. Alternatively, copy-and-paste from Concepts table can be used.</td>
</tr>
<tr>
<td>Source Article</td>
<td>Check this box if the source materials are not free and reside behind a paywall. A dollar sign ($) will appear on the Form when this box is checked.</td>
</tr>
<tr>
<td>ContextTable</td>
<td>Insert the table documenting the contextual conditions by right-clicking the cell → Insert Object → Create From File → Browse to and select the appropriate file. Templates can be found in existing Concept directories. Ex: \NASA\c_nasa.xlsx</td>
</tr>
</tbody>
</table>

---

**1. ConceptID**

Enter the ConceptID associated with the superordinate Concept Upon doing so the DisplayID will automatically populate - Record DisplayID.

**2. DisplayImage**

Double-click the cell → Add... → Navigate to and select the appropriate Display Image.

**3. DisplayTitle**

Enter the Display Title with appropriate notation. Ex: (2) E-SVS EICAS.

**4. DisplayTitle_**

Enter the Display Title without notation. Ex: E-SVS EICAS.

**5. **[Display Type]**

Click the relevant checkbox corresponding to the type of Display being entered.

**6. Source Article**

Link to the Source Article by right-clicking on the Source Article cell → Hyperlink → Edit Hyperlink. Navigate to and select the source article. Repeat for 2nd and 3rd Source Articles. Alternatively, copy-and-paste from Concepts table can be used.

**7. Source Article Free**

Check this box if the source materials are not free and reside behind a paywall. A dollar sign ($) will appear on the Form when this box is checked.

**8. ContextTable**

Insert the table documenting the contextual conditions by right-clicking the cell → Insert Object → Create From File → Browse to and select the appropriate file. Templates can be found in existing Concept directories. Ex: \NASA\c_nasa.xlsx.
## Entering New Elements

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Instructions for Entering Elements</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. ConceptID</td>
<td>Enter the ConceptID associated with the superordinate Concept. Upon doing so the ElementID will automatically populate - Record ElementID</td>
</tr>
<tr>
<td>2. DisplayID</td>
<td>Enter the DisplayID associated with the superordinate Display.</td>
</tr>
<tr>
<td>3. Duplicate</td>
<td>Check the Duplicate checkbox only if this exact Element has been used before.</td>
</tr>
<tr>
<td>4. Jump</td>
<td>Check the Jump checkbox if the Element has no subordinate Features (i.e., it actually is a Feature itself)</td>
</tr>
<tr>
<td>5. Control</td>
<td>Check the Control checkbox only if the Element is a Control Element (Section 4.4).</td>
</tr>
<tr>
<td>6. ElementImage</td>
<td>Double-click the cell → Add... → Navigate to and select the appropriate Element Image. If the Element is being jumped, do NOT provide an Image unless it is also a Control Element.</td>
</tr>
<tr>
<td>7. ElementTitle</td>
<td>Enter the Element Title with appropriate notation. Ex: (3) Heading Line If the Element is being jumped, append <em>Jump</em> to the end of the Element Title. Ex: (1) Data Block <em>Jump</em></td>
</tr>
<tr>
<td>8. ElementTitle_</td>
<td>Enter the Element Title without notation. Ex: Heading Line If the Element is being jumped, only enter <em>Jump</em> - no element -</td>
</tr>
<tr>
<td>9. Source Article</td>
<td>Link to the Source Article by right-clicking on the Source Article cell → Hyperlink → Edit Hyperlink. Navigate to and select the source article. Repeat for 2nd and 3rd Source Articles. Alternatively, copy-and-paste from Concepts table can be used.</td>
</tr>
<tr>
<td>10. Source Article Free</td>
<td>Check this box if the source materials are not free and reside behind a paywall. A dollar sign ($) will appear on the Form when this box is checked.</td>
</tr>
<tr>
<td>11. ContextTable</td>
<td>Insert the table documenting the contextual conditions by right-clicking the cell → Insert Object → Create From File → Browse to and select the appropriate file. Templates can be found in existing Concept directories. Ex: \NASA\c_nasa.xlsx</td>
</tr>
</tbody>
</table>

**Note:** Elements being jumped do not have a unique ElementTitle_ other than *Jump* - no element- nor do they have an ElementImage. This is to prevent confusion while browsing in Hierarchy View and also to prevent these Elements from showing up in Queries.
## Entering New Features

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Instructions for Entering Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. ConceptID</td>
<td>Enter the ConceptID associated with the superordinate Concept</td>
</tr>
<tr>
<td>2. DisplayID</td>
<td>Enter the DisplayID associated with the superordinate Display</td>
</tr>
<tr>
<td>3. ElementID</td>
<td>Enter the ElementID associated with the superordinate Element</td>
</tr>
<tr>
<td>4. Duplicate</td>
<td>Check the Duplicate checkbox only if this exact Feature has been used before</td>
</tr>
<tr>
<td>5. Control</td>
<td>Check the Control checkbox only if the Feature is a Control Feature (Section 4.4)</td>
</tr>
<tr>
<td>6. FeatureImage</td>
<td>Double-click the cell → Add... → Navigate to and select the appropriate Feature Image.</td>
</tr>
<tr>
<td>7. FeatureTitle</td>
<td>Enter the Feature Title with appropriate notation. Ex: (4) Target Aircraft</td>
</tr>
<tr>
<td>8. FeatureTitle</td>
<td>Enter the Feature Title without notation. Ex: Target Aircraft</td>
</tr>
<tr>
<td>9. Source Article</td>
<td>Link to the Source Article by right-clicking on the Source Article cell → Hyperlink → Edit Hyperlink. Navigate to and select the source article. Repeat for 2&lt;sup&gt;nd&lt;/sup&gt; and 3&lt;sup&gt;rd&lt;/sup&gt; Source Articles. Alternatively, copy-and-paste from Concepts table can be used.</td>
</tr>
<tr>
<td>10. Source Article Free</td>
<td>Check this box if the source materials are not free and reside behind a paywall. A dollar sign ($) will appear on the Form when this box is checked.</td>
</tr>
<tr>
<td>11. ContextTable</td>
<td>Insert the table documenting the contextual conditions by right-clicking the cell → Insert Object → Create From File → Browse to and select the appropriate file. Templates can be found in existing Concept directories. Ex: \NASA\c_nasa.xlsx</td>
</tr>
<tr>
<td>12. [Formatting]</td>
<td>Check all relevant checkboxes corresponding to the formatting of the Feature being entered. Ex: For a green chevron ownship, the user would check Green, Ownship, Chevron, All</td>
</tr>
</tbody>
</table>

- **Note:** Periodically individual Columns within a specific table may randomly re-order
- **This is a known bug within Microsoft Access 2007**
- Users can select Columns and move them to any desired position in the Table
Entering Framework Information

- Entering new information for the Frameworks is the same process as it was for the others levels of the Hierarchy.
- There are two types of fields:
  - Checkboxes
  - Free text entry
    - There is a 255 character limit for text fields
- For the Behavioral Framework, add entries to the relevant fields in the Concepts table.
- For the Evaluation Framework, add entries to the relevant fields in the Evaluations table.
- For the Results Framework, add entries to the relevant fields in the Evaluations table.
Entering Framework Information

• The Framework variables can be found and viewed in the following locations:
  – Behavioral Framework variables – Concepts Table & Concepts Form
  – Evaluation Framework variables – Evaluations Table & Evaluation Form
  – Results Framework variables – Evaluations Table & Results Form
• The 3 Frameworks are linked to one another and to the original Hierarchy with buttons
Entering Framework Information

• For the Evaluation and Results Frameworks, users should also copy-and-paste details from the associated Concept in the Concepts Table
  – The ConceptID is required in order to link the Frameworks to the appropriate Concept
  – This is identical to the process used to link Concepts to Displays, Elements, Features, etc.
Editing Forms and Queries

• The various Forms and Queries within the Database can be edited
  – This is only advised for expert Access users
  – Make sure to maintain backup copies of the Database that are in working condition

• To edit a Form or Query, open it from the navigation pane on the left side of the screen
  – Then, go to View → Design View to begin making edits
• To add Buttons to the Concept Index, open the Concept Index in Design View
  – Navigate to the appropriate Tab and copy-and-paste an existing Button
  – Move it into the desired position and edit the text on the Button by changing its Name and ControlTip Text in the Property Sheet
  – Then, to direct the button to the correct Concept, travel to the Event Tab in the Property Sheet and click … next to On Click
  – Next, click on the second row, the GoToRecord Entry, and change the Offset field in the Action Arguments at the bottom of the page to match the record number associated with the new Concept being added
  – The Record associated with the new Concept can be found by opening the Concept Table, selecting the new Concept, and looking at the record (e.g., 7 of 31) on the bottom left of the Table
Editing Forms and Queries

- To update the Acronyms, open the Acronym Table and enter the new acronyms and their definitions.

- The Bibliography, User Guide, and Author Contacts are all .pdf files located in the `\LINKS\` directory along with the source .docx file. To update any of these files, edit the .docx file and recreate the .pdf file from the .docx file.
Troubleshooting & Maintenance
Maintenance

• Occasionally, during database editing and construction, it is advised that the user take steps to clean up the database

• As new entries are created and as the Forms are modified, the size of the database file will grow

• Occasionally, the size will grow in a disproportionate manner relative to the changes that have been made and accepted

• Any time this happens, users can correct the problem by:

<table>
<thead>
<tr>
<th>Steps Required to Compact and Repair Database</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open the Database</td>
</tr>
<tr>
<td>2. Click the Office Button in the top left corner</td>
</tr>
<tr>
<td>3. Click Manage in the left panel</td>
</tr>
<tr>
<td>4. Click Compact and Repair Database</td>
</tr>
</tbody>
</table>

• When editing, it is recommended that this procedure be run at least once a day, and more often if major changes are being made
Troubleshooting

- **Problem:** Buttons within database do nothing
- **Solution:** Ensure that Macros are enabled

- **Problem:** The size of the database file (Database.mbd) is greatly expanded during database construction
- **Solution:** This may be normal or the user may need to Compact and Repair the Database

- **Problem:** The user changes the database in some way, either accidentally or intentionally and wants to return to a previous state
- **Solution:** If the change cannot be “Undone” then the user should revert to the original version of the database. As recommended in Section 2.1, users should keep an untouched version of the database for this reason. Also, it is recommended that users at a minimum make daily backups when changing the database.
Troubleshooting

• **Problem:** Hyperlinks do not open
  • **Solution 1:** The Database.mdb file may have been moved from its home directory. The file should remain in \Access Database\Database.mdb\ See Section 2.2 for more details. Either place the .mdb file back in the home directory or re-download the database from the source zip file

• **Solution 2:** The source materials (file, web address, image) may have been moved from their home directory. Either move the file back to the originally specified directory or edit the hyperlink and link to the new location

• **Solution 3:** Ensure that multiple instances of the Access Database are not open. If so, close both instances and re-open the database

• **Problem:** The Columns within a specific Table are now in a different order
  • **Solution:** This is a known error within Microsoft Access. Users can select columns and re-order them to any desired position in the Table
This work was technically monitored by Dr. Kara Latorella at NASA Langley’s Crew Systems & Aviation Operations branch, and funded by a reimbursable agreement from the Federal Aviation Administration’s Human Factors Division (ANG-C1).
# Flight Deck Interval Management (FIM) Display Elements, Information and Annunciations Database User Guide

**Author(s):**
Lancaster, Jeff; Dillard, Michael; Alves, Erin; Olofinboba, Olu

**Performing Organization Name(s) and Address(es):**
NASA Langley Research Center
Hampton, Virginia 23681

**Sponsoring/Monitoring Agency Name(s) and Address(es):**
National Aeronautics and Space Administration
Washington, DC 20546-0001

**DISTRIBUTION/AVAILABILITY STATEMENT**
Unclassified - Unlimited

**Supplementary Notes**
Langley Technical Monitor: Kara A. Latorella

**Distribution/Availability Statement**
Unclassified - Unlimited
Subject Category 01
Availability: NASA STI Program (757) 864-9658

**Security Classification of:**
- **a. Report:** U
- **b. Abstract:** U
- **c. This Page:** U

**Limitation of Abstract:** UU

**Number of Pages:** 112

**Telephone Number (Include area code):**
(757) 864-9658

**Subject Terms:**
Flight Deck Interval Management (FIM) Display Elements, Information and Annunciations Database User Guide